
The Villages Computer Club 

June 8th at Lake Miona 1:00 pm 
 
This week's program will feature a presentation by Bob Petrilak on Picasa. 
Picasa is an image organizer and image viewer for organizing and editing 
digital photos, plus an integrated photo-sharing website. 
 
Following the presentation will be refreshments, 50/50, door prizes and a 
problem solving session.  
 
If you have a computer problem you can't resolve, fill out the problem report 
form found at http://thevillagescomputerclub.com/meetings.php and bring it to 
the meeting. 
 
Sign up to be on the VCC email list at the VCC home page (below) 
 
For more information on the VCC please reference the clubs web site at: 
http://thevillagescomputerclub.com/  
 
Guests are always welcome.  
For information, email Paul Rabenold at TVCC.Pres@gmail.com 
 

Don't forget !! Computer Plus on June 7th 1:00 pm at Laurel Manor 
Recreation Center, Backup and Storage. 
http://www.villagescomputerplus.com/ 
 

******************************************************** 
2 new services I've used and added to my Jmax Good Services List 
1. **Handyman - Mitch Kuputz - 352-350-0207 

Reseal driveways 

Clean and paint aluminum awnings 

2. **Handyman - Ron Hawk 352-245-6373; cell 347-446-1380 

Pressure cleaning, Carpet cleaning, painting, plumbing,electrical 
****************************************************************************** 

We must stay informed. 
Will we ever run out of Internet Space? We already have!!!! 
http://www.google.com/intl/en/ipv6/ 
http://www.google.com/intl/en/ipv6/faq.html 
****************************************************************************************************
************* 



For you who attended the Tuesday iPAD meeting, thank you. We had 207 
people. I have attached some of the information we discussed. 
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I would also like you to email me about ideas or topics for future meetings. We 

would like to discuss topics you want. 

There is an app that discusses most of what we covered on Tuesday. It is 

available in the app store for free and is called: SCOTutor for iPad. It is about 

2hr and is broken down into chapters for easy viewing. It is basic basic, but has a 

wealth of valuable information. 

If you have any questions, let me know. 

Thank you for interest, 

Art Fenn 

430-0252 

******************************************************************************

***************** 

Villages.net Email program 

 

1. Click COMPOSE to bring up a new email form 

2. If you have the addresses already entered into the address book, the 

list will show on the right side of the email form. 

3. To send a blind copy, click the name to whom the BCC is to go, and 

click BCC below the address box.  

4. Place your own address in the TO box , or click the address to whom 

the email will go and select TO: 

 

NOTE: If you are sending to multiple addresses send as 
Blind Copies or all those addresses WILL be harvested 
at some point in time by the ‘creepos’ computers who 
run their computers 24/7 harvesting addresses from 
forwarded emails and selling them to porn sites, 
marketers,etc. All those in your list will start receiving 
huge amounts of spam. 
 

Can I get an extra e-mail box? 
You may have 2 screen names in your thevillages.net inbox account. 

Additional mailboxes are $2.95 per box per month, each with 20 MB's of space on the 
mail server. 



******************************************************************************

************************************* 

Your Golf Tee Time Reservations  

 

IF you're using thevillages.net for your golf tee times and email, You can select the 

option to have your golf reservation confirmed via email. 
 

1.Log onto thevillages.net and click Golf 

2. Select your ID number and your pin # 

3. Scroll down to Personalized Settings in the list 

4.Select the Option to have tee time confirmed via email, enter your 

thevillages.net email address. 

5. IF you are using another email address as your default email, Click on "email" 

on the menu at the top to go to your villages.net account  

4. Click "Settings" at the top 

5. Click on "Options" and you will see "Mail Forwarding" down the page. 

6. Enter your default email address in the box . 

7. Check the box to 'not leave a copy in your villages.net account'.  
 

Note: You may select to place an order for golf only for a reduced price by calling thevillage.net 

office. 

******************************************************************************

******************** 

SET UP OUTLOOK EXPRESS EMAIL FOR THE VILLAGES.NET 
Note: Win 7 operating system does not have Outlook Express, but does have 
Outlook or Windoes Mail. 
 
1. Double-click the Outlook Express icon on your desktop 
2. Click "Tools", and then "Accounts" and then click the “Mail” tab. 
3. Click"Add" button on far right. 
4. Click "Mail" 
5. Type the name of the people that will be using this email account. For example, "Bob 

& Mary Smith". Then click "Next". 
6. Type your full "Villages. NET" email address. For example, 

bobandmarysmith@,thevillaqes.net Then click "Next". 
7. Type mail.thevillaqes.net for BOTH the Incoming and Outgoing mail servers, then 

click “Next”. 
8. Type your login name and password. Remember on thevillages.net both are case 

sensitive. Then click "Next". 
9.Click "Finish". 
10.Now, the Internet Accounts Window will be displayed. Click on the “Properties” 
button on the right side and then click the “SERVERS” tab. Near the bottom put a check 
next to “My server requires authentication”. 



11.Click “Apply” and “OK”. Click “Close”. 
 
NOTE 1: Repeat steps 1 through 11 for any additional email accounts you want to 
set up. 
 
Note 2. If you have more than one mail account listed on the "Mail" tab of the 
window that now appears on your screen, then make your "Villages.net" e-mail 
account the default e-mail account by clicking it and clicking "Set Default" 

 Click "Close" 
 
To disconnect from TheVillages. NET, double-click the 2 green computers at the lower-
right corner of the screen, then click the "Disconnect" button... 
 
******************************************************************************

************************************************* 

Changing Web page fonts and background colors 

When Web authors and designers create Web pages, they often specify particular type (font) 

faces, colors, sizes, and background colors. These settings are specified for each item, or in a 

"style sheet", which is a type of template for specifying how different styles should appear 

throughout a Web page or site. 

You can override any or all of these settings, which is useful if you have limited or low vision. 

You can specify your font and color preferences for all pages that do not use style sheets, and 

then you can specify whether to use any or all of your preferences on pages that use style sheets. 

*********************************** 

To change the appearance of the Windows toolbar 

• You can add or remove standard toolbar buttons, use smaller toolbar buttons like the ones 

used in Microsoft Office, and change the order they are displayed on the toolbar. Just 

right-click the toolbar, and then click Customize.  

• You can move or resize the Address bar and Links bar by dragging them up, down, left, 

or right. You can even move them into the menu bar!  

• You can hide the Address bar or Links bar by right-clicking the toolbar, and then clearing 

the check mark for each item you want to hide.  

• You can add items to the Links bar by dragging the icon from the Address bar or 

dragging a link from a Web page.  

• You can rearrange items on the Links bar by dragging them to a new location on the bar.  

To display Web page text larger or smaller 

• On the View menu, point to Text Size, and then click the size you want. . 



To change how Web page colors are displayed 

1. On the Tools menu in Internet Explorer, click Internet Options.  

2. On the General tab, click Colors.  

3. Change the settings as needed.  

To specify fonts and colors to always use for Web pages 

1. On the Tools menu in Internet Explorer, click Internet Options.  

2. On the General tab, click Accessibility.  

3. Change the settings as needed 

*********************************************************** 

 
Connect to an Available Wireless Network 

When you connect your computer to a network by using an Ethernet cable, Win 7 

automatically creates the network connection. To connect to a wireless network for the first 

time, YOU need to make the connection. 

Connect to an Available Wireless Network 

1. In the notification area look for either a single monitor screen or a stack of reeds toy. 

This will be the icon for the wireless connection. Click that icon to open the wireless 

network box where there will be a list of wireless networks that are available. If the 

network says Secured, it means you must enter a wep or wpa code before you can connect. 

2. There may also be a box to click to show Available Wireless Networks. you should 

recognize your own wireless network since you set it up. 

3. Click the wireless network to which you wish to connect, then click the Connect button. 

If necessary enter the WEP or WPA password.  

4. In Win 7 each network profile includes these settings: 

 a. Network discovery - can the computer see and be seen by other computers 

connected to the same network. 

 b. File and printer sharing - shows if network users can access files and printers you 

have shared. 

 c. Public folder sharing - shows if network users can access files stored in the Public 

folders in your computer. 

 d. Media streaming - shows if network users can access music, videos and pictures 

stored in your media library. 

 e. File sharing - shows the security requirements for devices that connect to your 

computer's file sharing connections. 



 f. Password-protected sharing - shows if files are available to any network user or 

only to users with user accounts in your computer. 

 g. HomeGroup connections - shows if only those with User Accounts can be joined 

to your homegroup.  

Note: Network connection types and homegroups may not be available on a computer 

running an earlier version of Windows. 

**************************************************************************** 

FYI 

 

Hidden Billionaire Morse a Man Behind 
Curtain at Villages 

By Brendan Coffey - Jun 4, 2012  

Billionaire H. Gary Morse, 75, controls almost every facet of life at the Villages, one of 
the world’s largest retirement communities.  

On a 33-square-mile parcel 15 miles south of Ocala, Florida, halfway between 
Jacksonville and Tampa, he’s built and sold more than 44,000 homes since 1983. He’s 
created 39 golf courses and developed 4.5 million square feet of commercial space, 
including two hotels, 60 restaurants and two movie theaters.  

Morse owns the local newspaper, a television channel and an AM radio station. His 
realty company controls 60 percent of the re-sale market in the Villages, whose 
commercials have been fixtures on the Golf Channel. His bank lends to retirees fleeing 
south; his insurance company provides them coverage. He even gets paid to pick up 
the trash and organize tee times. For all his ubiquity, most outside of Florida have never 
heard of him.  

“He’s kind of like the Wizard of Oz,” Andrew D. Blechman, author of “Leisureville,” a 
book on retirement communities, said in a phone interview from his office in Great 
Barrington, Massachusetts. “He’s the man behind the curtain. No one really knows him 
at the Villages.”  

In 2011, the Holding Company of the Villages Ltd., which is owned by Morse and his 
family, generated at least $550 million in revenue, according to regulatory filings. Based 
on the value of his various businesses and real estate -- plus the almost $1 billion in 
estimated profits the closely held company has earned over 29 years -- Morse and his 



family are worth more than $2.5 billion, according to data compiled by Bloomberg. He 
has never appeared on an international rich list, Bloomberg Markets magazine reports 
in its July issue.  

Morse, who owns at least four jet planes and a 147-foot yacht, has become one of 
America’s wealthiest real estate tycoons with the help of tax-exempt municipal bonds 
issued by special government entities he’s created to fund the expansion of the 
Villages. He plans to use more bonds, which have drawn scrutiny from Florida’s 
governor and the U.S. Internal Revenue Service, to help fund another 11,000 homes 
and 4.2 million square feet of commercial space, according to recent bond offering 
statements.  

Gary Lester, a spokesman for the Villages, said in an e- mail that Morse declined to 
comment for this account.  

Special Taxing Districts  

Since 1992, Morse has raised at least $1.16 billion through 41 tax-exempt bond and 
note offerings in 11 special taxing districts, according to documents filed with the 
offerings. The districts use the proceeds to buy assets and services -- such as golf 
courses and water utilities -- from Morse, who has earned more than $900 million from 
the transactions.  

Florida state law allows for the special taxing districts, including entities known as 
community development districts, to issue bonds exempt from federal income tax so 
long as they perform a “wholly public purpose,” according to IRS guidelines.  

Suspecting millions of taxpayer dollars were wrongfully flowing to developers, Florida 
Governor Richard Scott issued an executive order in January 2012, seeking a review of 
the state’s 1,600 special taxing districts.  

“They aren’t elected officials,” Lane Wright, Scott’s press secretary, said in a phone 
interview when asked about developers requiring homeowner fees to back munis. “They 
are not accountable to the taxpayer.”  

On March 28, 2012, Morse donated $50,000 to Let’s Get to Work, Governor Scott’s 
2014 election fund, according to a donor list posted on its website. His three children 
each donated $10,000 the same day; the Villages made a $100,000 corporate donation 
as well. Morse is a co-chairman of the Florida finance committee for Republican Mitt 
Romney’s presidential campaign.  

Developer’s Alter Ego  



One person in the state’s Office of Policy and Budget has been gathering information on 
the special districts, Wright said. Scott, a Republican, should have an estimate as to 
how long a thorough review will take by the end of June.  

Morse’s community districts have also drawn the ire of the IRS, which has investigated 
whether $426.6 million of bonds issued between 1993 and 2004 by the Village Center 
Community Development District should have been tax-exempt, according to letters the 
agency sent the district’s board of supervisors.  

“There is nothing about the establishment or operation of the Center District that 
indicates it has a wholly public purpose,” the IRS said in a memorandum to the district’s 
board dated April 26, 2012. “The Center District has in effect been operated as the alter 
ego of the Developer.”  

The IRS memo was in response to the district’s request for “technical advice” into their 
bonds’s compliance with the tax exemption laws. Dean Patterson, an IRS spokesman, 
said in a phone interview the agency couldn’t comment on anything having to do with a 
taxpayer, including special government districts. As of May 17, 2012, the investigation 
was active, according to a brief sent to the district’s board.  

‘Perfect Issuer’  

A Freedom of Information Act request to the U.S. Treasury Department made by 
Bloomberg News for more of the correspondence between the district and the IRS was 
denied April 13, 2012, because tax records are confidential.  

The coupon and principal payments for Morse’s district bonds are made using 
assessments and amenities fees paid by the Villages’s 84,000 residents who shell out 
as much as $1,740 a year to enjoy their clubhouses, pools and golf courses. None of 
the Villages’s special districts have ever defaulted on their bonds.  

“That’s your perfect issuer,” Andrew Sanford, an analyst at ITG Holdings LLC, a Naples, 
Florida-based hedge fund specializing in municipal bonds, said in a phone interview. 
“They issue bonds. Things get built out very quickly. They have good debt service 
coverage.”  

ITG owns two Village Center bonds with a combined face value of $200,000. The 
company owns $30 million in municipal securities.  

Real Estate by Mail  

Gary Morse was born to Mary Louise and Harold Schwartz. The couple divorced around 
1947, when Morse was about 10 years old. Mary Louise remarried Clifford Morse, 
according to Blechman. The duo raised Gary in Central Lake, Michigan, where the 



family ran a restaurant and entertainment complex called Brownwood, according to a 
Jan. 8, 2012, account in Morse’s Villages Daily Sun newspaper.  

Schwartz moved south and eventually purchased a few thousand acres of scrub land 15 
miles south of Ocala, Florida. In 1959, he started selling lots by mail. When federal law 
banned such sales a few years later, Schwartz sold plots to mobile home owners.  

By 1983, only 400 lots had trailers on them. At his father’s urging, Morse moved to 
Florida that year to take over the business. Rather than hawk vacant lots, Morse 
decided to build homes -- plus pools, restaurants and lots of golf courses -- on 
speculation, hoping to sell them to retiring northerners.  

By 1986, Morse was selling more than 500 homes a year. A decade later, annual 
revenue crested $100 million. Between 1986 and the first quarter of 2012, the Holding 
Company of the Villages generated $8.23 billion in total new home sales revenue.  

Based on the average annual profit margin of four publicly traded homebuilders with 
Florida operations, the company has probably made almost $1 billion in profit from 
those sales.  

Colony Villa  

Morse’s fortune was built by owning almost every aspect of the Villages. The Villages 
builds the homes through subcontractors; a 1,648-square-foot Colony Villa starts at 
$120,000, while an upgraded 5,139-square-foot Grandview home sells for $1 million.  

When Morse sells the homes, loans to buyers are often made via his $1.4 billion 
(assets) Villages Bancorporation. A subsidiary, Citizens First Bank, provides consumer-
banking services to residents. According to a regulatory filing, the bank was worth $96 
million in 2011. Morse and his family own 61 percent of the bank, according to a reply to 
a IRS questionnaire in 2011.  

Morse is the landlord of the Villages’s 4.5 million square- feet of commercial space 
which houses dozens of restaurants, retailers and doctors offices. A few commercial 
lots have been sold to retailers such as Target Corp. (TGT) The remainder is owned by 
Morse and his children, according to bond offering documents.  

The value of these properties is about $400 million, according to data compiled by 
Bloomberg. The calculation is based on comparable market data -- vacancy rates, 
rents, and capitalization rates -- supplied by research firm CB Richard Ellis.  

In 2006, Morse transferred most of the direct ownership in the holding company to his 
three children: Mark Morse serves as President of the company; Tracy Mathews 
oversees Villages design; and Jennifer L. Parr is a director. Gary Morse retained the 
largest block of voting shares, and is credited with the family’s fortune, according to the 
methodology used to compile the Bloomberg Billionaires Index.  



Cracker Bay  

Property records show Morse owns a $1 million house in the Villages. He has four jet 
planes -- including a 21-seat Dassault Falcon 900 and two 22-seat Dassault Mystere-
Falcon 50s, which can fly 3,623 miles without refueling -- owned through the Villages 
Equipment Co.  

He also has a 147-foot yacht, Cracker Bay, according to the Orlando Sentinel and 
Tampa Bay Times newspapers. The Cayman Islands-flagged vessel can accommodate 
12 guests and a full-time crew of nine, according to Charterworld Ltd.  

Morse and his family own 40 percent of Lazy B Cattle Ventures LLC. Current and 
former employees own the rest of the cattle farm, which uses some of the Florida land 
near the Villages that Morse plans to develop, according to the IRS.  

One-third of Morse’s estimated fortune comes from proceeds from selling assets to the 
Villages with bondholder money. In 1992, Morse created the Village Community 
Development District No. 1, the first of 11 entities that have issued $1.16 billion in 
munis, at least $900 million of which has been paid to Morse for assets and services.  

Pickleball, Golf  

Each time he created a district to issue bonds, Morse created a five-member board to 
run the community in lieu of a municipal government. The boards that approved 38 of 
the bond offerings were staffed almost entirely with his employees at the time the bonds 
were sold. Three of the Villages’s 41 bond offering statements are not available through 
the Municipal Securities Rulemaking Board database.  

In 1993, the Village Center Community Development District issued $26 million in 
bonds. It used $20.2 million to acquire Sunbelt Utilities Inc., a water utility servicing 
5,249 Villages residences, according to the bond offering statement. The district’s board 
was comprised of Morse and four other Villages employees. Not disclosed in the bond 
offering statement: the fact that Morse and his father owned Sunbelt, according to 
Florida state records.  

The bond offering included a clause providing $3.69 million in post-sale fees to Morse 
and his father to connect another 3,351 homes to the system.  

Other bond issues show there is no operation at the Villages too small to profit from. In 
1996, Village Center CDD raised $17 million to buy assets from Morse, including seven 
lakes, 12 pickleball courts and 36 holes of golf. The offering included a provision to pay 
Morse $26,000 annually for taking tee times at those four executive courses.  

‘Government by Developer’  



The IRS began looking into Morse’s bonds in 2009. Details of the agency’s investigation 
were revealed when a website critical of Florida development districts posted a letter 
dated May 4, 2009, from the agency to the Villages.  

According to the letter, the IRS said it believed 2003 Village Center Community 
Development District bonds overpaid Morse for golf courses and other structures. The 
bonds paid Morse $60 million for amenities that only cost him $7.5 million to build, the 
letter said.  

The IRS also believed some of the assets the district bought from Morse in the 2003 
offering were ineligible to be purchased with a tax-exempt bond. One such asset: 
guardhouses that prevented public access to the Villages even though its roads are 
public property. At the time, all five members of the district supervisory board were 
employees of Morse.  

The district defended its appraisal methodology, telling the IRS in a subsequent letter 
that it was buying forward revenues derived from amenities fees in addition to the 
assets themselves.  

The IRS said it also believed Morse violated the intent of the law allowing special 
government districts by structuring a district with no residents at all and suggested other 
bonds may be taxable. Florida law indicates developers can create districts -- and 
appoint their supervisors -- as long as they are 1,000 acres and will eventually reach 
250 voters who can independently elect a district board.  

The districts were used “to perpetuate this ‘government by developer’ phase 
indefinitely,” wrote IRS examiner, Dominick Servadio Jr., in a 2009 letter to the Village’s 
CCD chairman. The May 2012, IRS brief said the agency believed that the 167- acre 
Village Center CDD and the 432-acre Sumter Landing CDD both failed to meet state 
requirements to be a district.  

Settlement Talks  

In 2009, the IRS requested a settlement requiring the Village Center and Sumter 
Landing districts to pay $16.5 million tax on the then-outstanding bonds, refinance $355 
million of the bonds through taxable bonds, and to refrain from issuing municipal bonds 
in the future. The settlement was probably declined given the continuing investigation.  

Since 2011 another Morse district, the Village Community Development District Number 
9, has issued two muni bond offerings. More than $95 million of the $109 million raised 
went to buy water management assets from Morse.  

“The IRS isn’t going to waste its time with the Villages,” Dan Carter, President of hedge 
fund ITG Holdings said in a phone interview. “There are going to be a lot of others that 
the IRS will have an easier time proving their point with. The Villages is more gray.”  



To contact the reporter on this story: Brendan Coffey in Boston at 
bcoffey10@bloomberg.net  

To contact the editor responsible for this story: Matthew G. Miller at 
mmiller144@bloomberg.net  

®2012 BLOOMBERG L.P. ALL RIGHTS RESERVED.  

More: http://www.businessweek.com/news/2012-06-04/hidden-billionaire-
morse-a-man-behind-curtain-at-villages#p1 

******************************************************************************

************************************* 

More FYI Click here: Bishops Prepare for Largest Civil Disobedience Since the 60s | 
LifeNews.com  
****************************************************************************************************
********************* 
Polish Salt Mines - miners built a subterranean cathedral. Amazing!!! 
http://acidcow.com/pics/25326-wieliczka-salt-mine-v-an-astounding-subterranean.html 
****************************************************************************************************
***** 

JmaxJmaxJmaxJmax  

Jmax's Website http://www.jmaxbits.com/ 
Jmax Bits Newsletter is now posted each Monday & Thursday on the website. 
You have the option for a .pdf or a .rtf file. 
 
1.For help with a computer problem, put HELP in the subject line and give me info 
about the computer you're using, if you know it.  
 
2.To view or print Jmax Bits Good Services List in the Villages area, click link 
www.jmaxbits.com 
 
3. To sign up for the non-computer newsletter, send an email to 
VLGSClassifieds@aol.com. Put SUBSCRIBE in the subject line. To send an Ad, 
place AD in the subject line. 
 
4. The Villages Computer Club's web page: Click here: Welcome To The Villages 
Computer Club 
To add your name to the VCC announcements list, send email to TheVCC-
subscribe@yahoogroups.com 
 

5. Fred Benson's website www.thevillagescomputerbasics.com  



 


